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Preface

The Legato NetWorker User’s Guide explains how to use

NetWorker’s backup and recover software from a client

workstation. The User’s Guide shows client users how to back up

files and directories to the NetWorker server on an as-needed

basis using the Backup window, and how to browse the on-line

index to recover files using the Recover window. For information

on server configuration and administration, refer to the Legato

NetWorker Administrator’s Guide.

Audience

Those who will benefit most from this manual are end-users and

system administrators who use NetWorker to back up and

recover data from a client workstation.

Conventions

This manual uses conventions to make information easy to access

and understand. The following list describes the conventions:

4 Command names are displayed in a bold typeface. For

example:

To start NetWorker, use the networker command.

4 Examples of what you type are displayed as a bold fixed-

width typeface. For example:

mars% networker &
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4 Names of panels and buttons are displayed as a Helvetica

typeface. For example:

Press the Dismiss button to close the Help window.

4 Important pieces of information and cautionary notes that

prevent you from making a mistake are marked with the tag

“Important.” For example:

Important ~ Remember that if you select a server other than the default

one for backing up files, you must recover your files from that

server.

1 Tips or suggestions that you do not have to follow but are

hints for using NetWorker are marked with the tag

“Tip.” For example:

Tip «== Keep the Main window open during every backup or recovery

to monitor the progress of the session.

4 Directory pathnames, machine names, and new terms are

displayed as an italic typeface. For example:

The NetWorker programs are located in /usr/opt/networker/bin.

The media pool is the collection of backup media recognized

and managed by NetWorker.

Contacting Data General

Data General wants to assist you in any way it can to help you use

its products. Please feel free to contact the company as outlined

below.

vi
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Manuals

If you require additional manuals, please use the enclosed TIPS

order form (United States only) or contact your local Data

General sales representative.

Telephone Assistance

If you are unable to solve a problem using any manual you

received with your system, free telephone assistance is available

with your hardware warranty and with most Data General

software service options. If you are within the United States or

Canada, contact the Data General Customer Support Center

(CSC) by calling 1-800-DG-HELPS. Lines are open from 8:00 a.m.

to 5:00 p.m., your time, Monday through Friday. The center will

put you in touch with a member of Data General’s telephone

assistance staff who can answer your questions.

For telephone assistance outside the United States or Canada, ask

your Data General sales representative for the appropriate

telephone number.

Joining Our Users Group

Please consider joining the largest independent organization of

Data General users, the North American Data General Users

Group (NADGUG). In addition to making valuable contacts,

members receive FOCUS monthly magazine, a conference

discount, access to the Software Library and Electronic Bulletin

Board, an annual Member Directory, Regional and Special

Interest Groups, and much more. For more information about

membership in the North American Data General Users Group,

call 1-800-253-3902 or 1-508-443-3330.

End of Preface
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Overview

Chapier 1

Introduction

Legato NetWorker is an easy-to-use network backup and recover

product. Every user knows about accidental file loss and hard

disk crashes. With NetWorker, you can easily protect your

valuable files from loss by performing backups on an as-needed

basis in addition to the automatic backups scheduled by your

system administrator. And NetWorker’s straightforward

recovery lets you find and retrieve lost files easily and quickly.

NetWorker’s fast file recovery means you do not have to waste

time re-creating lost files. Just scroll through the window of

previously backed-up files to find the files that were lost.

NetWorker even shows you multiple versions of a file that were

backed up over time and lets you select the ones you want to

recover. NetWorker provides access to these powerful features

through an intuitive graphical user interface.

The NetWorker server is a machine with a backup device that

automatically backs up all the systems on a network. Once your

system administrator installs NetWorker and configures the

NetWorker server to recognize your system as a client, your files

will automatically be backed up to the NetWorker server.

However, you can request NetWorker to back up important files

at any time on an as-needed basis.

When you use NetWorker to back up your files, you are saving

them to backup volumes on the NetWorker server. The NetWorker

server keeps an on-line index of the backed-up files for you to

13
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browse when you want to recover a single file or a complete

directory.

NetWorker clients

cepa Fe

Backup device:

8mm (or other)

tape drive

pee

<= NetWorker server

After the NetWorker client software is installed on your system,

the system administrator will configure the NetWorker server so

that you can use the backup and recover services.



Chapter 2

Getting Started

In this section you will back up and recover files from a client

system using Legato NetWorker. Your system must be

configured as a NetWorker client for you to use NetWorker. The

requirements for NetWorker clients are listed in Appendix C of

this manual.

If NetWorker is currently running on your system, you will see

the NetWorker icon or Main window on your screen. Skip to the

section entitled “Quick Tour” to back up and recover a file.

If you do not see either the icon or the Main window, you have to

oom toe ee ee als ee

Nethorker

start NetWorker on your system.

Starting NetWorker

To invoke NetWorker, first change to your home directory or a

local filesystem:

% ed your_home_directoryoO

Then enter the networker command, followed by an ampersand

(&) to run NetWorker in the background, at the system prompt:

% networker &oO

15
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Tip «= You can invoke NetWorker from any directory. The files in

the directory you invoke NetWorker from are immediately

available for backup.

If you receive an error message while invoking NetWorker, there

may be problems with your network configuration. Refer to

Appendix C, “Requirements for NetWorker Clients” to confirm

that your system is configured correctly as a NetWorker client. If

you need further help, contact your system administrator.

e

Help@ File

Server: talus NetWorker 4.0/1

Sessions:

Messages:

Pending:
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NetWorker uses windows, pull-down menus and dialog boxes to

guide you in backing up and recovering files.

NOTE: The Administration pull-down menu is active only for

authorized NetWorker administrators. For information on

NetWorker system administration, see the Legato NetWorker

Admunistrator’s Guide or contact your system administrator.

The Operation pull-down menu contains the Backup, Recover, and

Volumes commands. Use this menu to back up and recover your

files. Use the Volumes command to display all the backup tapes

tracked by NetWorker. The Volumes command is explained in

more detail in Chapter 4, “Backing up and Recovering Files.”

The Operation pull-down menu is shown below:

Operation |

Miers asTINS AD

eBackup...

Recover...

Teittyog et
Rrilier Key ny

Volumes...

Tip "= The greyed-out commands in the Operation pull-down menu

are available only to the system administrator.

The File pull-down menu contains the Change Server, Change Polling,

and Exitcommands. The Change Server command allows you to

change your NetWorker backup server. Chapter 4 describes in

detail how to change your backup server in the section

“Changing the NetWorker Server.” Use the Exit command to

close out of the NetWorker program.

17
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The File pull-down menu is shown below:

ATA

File |

PChange Server...

Change Polling...

Exit

The Change Polling command allows you to change the polling

interval. Polling controls how often, in seconds, the data in the

Main window is updated.

To change the polling interval:

1. Select Change Polling from the File pull-down menu in the Main

window.

The Change Polling dialog box appears, as shown below.

OAS AD ARAREAALANLLALOUCURR CL COU EREEE TRUCE ODOR CLORNCRTRI TTY

Senna a

i é a2 Ok iCancel}f | Help :
a

Be

Sed eee eee eee eRe sou

2. Use the mouse to slide the Polling interval bar to the right or left

to select the desired polling interval. Notice the number of

interval seconds is displayed as you slide the bar.

3. Press Ok to apply the change.
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Using Help

You can learn about NetWorker by using the Help windows. You

can obtain on-line help on any menu item or window

component. The Help pull-down menu provides you with help on

the Main window, a list of help topics to browse, directions on

using help, and information on the version of NetWorker you are

using.

“Help

On

Topics

crepe RRS

Window

On Help

On Version

Select the Topic command the Help pull-down menu to open the

Topics Help window, as shown below.

19
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The an-line help provides a quick reference about many of
NetWorker’s features. To access help about a particular topic,

serol] though the list below and select the topic with the mouse.

If

Topics:

Setting locations

Showing Files Marked for Recovery

Suggestions for Easier Backup

Ayan Ress

Troubleshooting

a| Version

Versions

Volumes

rn :

icancel| a
.

: oesees

To see more information about a topic, select the title from the

Topics scrolling list. The help text for the selected topic appears in

the top window. The Topics scrolling list remains available in the

bottom window for selecting other topics.

For example, selecting the topic Backup produces the following

window:

20
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oceanssobetpao onsins is Core aceon
NetWorker supports both automatic network-wide backups and
as-needed backups af client system files and directories. Tao
request an immediate, as-needed backup, select Backup... from the
Operation pull-down menu af the Main NetWorker window.

Check that the correct Networker server is selected. The Server
is identified in the Main window. You can change servers using
the Change Server command if necessary. This is the Server that
the client files will be backed up to. The hostname of the
current client is displayed in the Client field. The pathname of
the current directory is displayed in the Selection field.

Change directories by entering the full pathname in the Selection
field or by highlighting the icon in the Backup window.

To perform an as-needed backup, first mark the files and
directories that you want to backup by selecting their
checkboxes. Then select Start backup... from the File menu of the
Backup window. You must select whether to compress files orfatale NS abate ies tet So asi. a Diath astute insta etn Sabha ase ee iaBS a naa ate ere er ce na eee

oes,he

eee NARMS RSH San aA Ha ASSL naas Oso a LO EO
qi Backup Options

qi Backup Status

4) Changing Administrators

qiChanging the Browse Time

Changing the Mode

Changing the Polling Interval

Year eecnen eCResi Na sEaSE SSR SC

To return to the Main window, press the Cancel button.

Using NetWorker Windows

NetWorker displays your files and directories using icons and

windows. NetWorker windows provide an easy-to-use

X Window System graphical user interface. This section shows

you how to use NetWorker windows.

21
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Open the Backup window by selecting the Backup from the Operation
pull-down menu.

EASA AAMAS NNR

Operation

———_ Backup...

Recover...

REELERT AYO

Volumes...

Position the cursor on the Operation pull-down menu and press

either the left or right mouse button, (depending upon how your

system is configured). When the pull-down menu appears,

highlight Backup to open the Backup window.
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The Backup window appears, as shown below.

Menu bar ——> }} file view

Server: atlas Client: titania

eanel : Selection: | {hone/ti tania/rebecca/pubs/

“ 8
Mount point icon —y 9g Ze ’ doc acl) doclt acl?

oO i } home g

_ dacis docid dociS docté

Directory icon Po [titania .
Lis QO | oO gO oO

: Q ) rebecca docl? docié docl9 doce

Highlighted directory en | pubs
: doc20 doc? doc22 doc23

File icon :

oO OQ QO| | doc24 doc25 docZ6 docs

bi _

Directory display File display

NOTE: The following sections describe the components of

the Backup window.

Menu Bar

The menu bar contains the File, View, and the Help pull-down

menus.

To use the File, View or Help pull-down menus, position the cursor

over the desired menu and hold down the right (or left) mouse

button to display the pull-down menus. By X Window System

convention, the first command in the menu will always be

chosen by default.

23
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Tip «= The left and right mouse button actions used in this manual

are the X Window System defaults. If you have problems

using the mouse, your mouse buttons may have been re-

programmed. See your system administrator for help.

On-line Help

To use on-line help, select the Help pull-down menu of the

window in question to read the on-line help message. You can

obtain help on the current window, menu item, or dialog box.

Selection Panel

The selection panel in the Backup window indicates the current

server and client. The Selection field indicates the full pathname of

the current file or directory and allows you to enter text to select

any pathname you choose.

Directory and File Display Areas

The window is divided into two display areas: a directory

display on the left-hand side and a file display on the right-hand

side. The size of the file display can be adjusted horizontally to

make it easier to see your files. The entire window can be

adjusted vertically. The display areas contain icons that

represent the files and directories in your filesystem.
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Icons

The icons you see in the window are described below. Use the

checkbox next to each icon to mark and unmark files and

directories for backup or recovery. (Some of the icons represent

UNIX terminology.)

AL] rebeces Folder icons represent directories.

aE etecce An open folder indicates that the tree structure of the
| directory, if any exists, appears in the directory display.

plansal]

aL] pe: A grey checkbox for a directory indicates that a

reports SUbdirectory has been marked for backup or recovery.

oa
A highlighted folder indicates the current selection. The

folder contents appear in the file display. A highlighted

folder is selected for menu actions.

pubs

Bod This icon represents mount points.

Sheet icons represent files.
1usr.doc

i A highlighted file is selected for menu actions.

QO
Tusr.doc

4 This icon represents symbolic links.
lib
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This icon represents block devices.
O&

fdo

4 fe This icon represents character devices.

console

Gj The cursor changes to a clock when NetWorker is

performing a task.

Window Controls

Slider —» By selecting the scrollbar or the triangular endpoints, or by

dragging the slider, you can navigate vertically or

Scroll horizontally in the directory and file displays.
bar ———»
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Quick Tour

The” Quick Tour” shows you how to back up your current

directory and how to recover a file using NetWorker. Follow the

instructions in this section to become familiar with NetWorker.

Chapters 3 and 4 have more detailed information on how to use

NetWorker.

If the NetWorker icon is displayed on your screen, select it to

display the NetWorker Main window, as shown below.

Helpaq File Operation

Server: talus NetWorker 4.0/1

Up since: Tue Dec 14 20:30:26 1993

Backups: 0 sessions

Recovers: 0 sessions

Devices:

= i
Sessions:

aS
Messages:

Pending:
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Backing up Your Directory

To demonstrate NetWorker’s functionality, you will first back up

a directory to the NetWorker server. The Backup window lets you

browse the filesystem to examine your directories. Then you can

mark files for backup.

To learn about NetWorker, you will mark an entire directory for

backup. Then you will unmark a file within that directory.

Finally, you will start the backup.

Open the Backup Window

Open the Backup window by selecting the Backup command from

the Operation pull-down menu.

dierrF:E

———_ Backup...

Recover...

v :

P¥ ft yh age oAPHIS ROS Dy oy

Volumes...
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The Backup window appears, as shown below.

File View Help

Server: atlas Client: titania

Selection: |
Ahome/titaniafrebecca/

= J oo of
= plang pubs reports

t home
O

Oo i titania

O = rebecca

i eke

pl

The pathname of the directory from which you invoked

NetWorker is displayed in the Selection field. The directory

display shows you a graphical representation of the path with

the current directory highlighted. The file display shows you the

contents of the current directory.
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30

—————+- Level

Expanding the Current Directory

Client: titania

Expand Branch

afrebecca/
Collapse Branch ;

File Details

File \Wew Help

Server: atlas Client: titania

Selection: | /home/ti tania/rebecca/pubs/

_ oO i oO } oO }
| - doc1 docit dacit

QO home :

/ titania QO O i Q |
O doc? doc13 doci4

O / rebecca

plansa] : :

— i pubs QO i QO ) QO )
doclé doci93 dac?

~ reports : .
= a A

a

Se acne

__-

SS A ADRS DBRS BUN EoABI WADA ADRIAN DED HAG NERD AARON AAS ARDEA ESS sohabonten nares ateannesraga neni

a Sn nr cn Sateen Sa ae Seni an aan
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Marking a Directory

To mark a directory for backup, use the mouse to select the

checkbox next to the folder that represents the directory that you

want to back up.

. yl | pubs

Notice that a checkmark (W) appears in the checkbox. Highlight

the folder to display its files. In the file display, notice that the

files contained in the marked directory are also marked.

| Server: atlas Client: titania

|) Selection: [Thome/ti tania/rebecca/pubs/ :

dale la} é
wy wy

doci docil}) docii

home

: L_ titania oY } xy |) wy }
a docl? docis docl4

rebecca N

3] plans “O “A “
| =| pubs wy al) al]
a)

docié doci3 doc? /
4

reparts A
| I TM~, | t | I oe

a. ht. 4
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When you mark a directory, its nested files and subdirectories are

marked as well. The checkboxes of the parent directories turn

grey to indicate that a subdirectory has been marked. Mount

points within a marked directory are not marked, since you can

only mark files within one filesystem at a time.

Tip You can also mark a directory by highlighting it and selecting

Mark from the File pull-down menu. The effect is the same as

selecting the checkbox.

Unmarking a File

You can exclude a file from the backup by unmarking it. In the

file display, select the checkmark next to a file to unmark it. The

checkmark disappears and the file is excluded from the backup.

File View

Server: atlas Client: titania

‘| al a
daocl docit

Selection: | ghome/ti tania/rebecca/pubs/

Sena a Re a
titania doc? docl3

= | rebecca O i oO if
dociS dacié

—5L_] plans : ,

me [fll al
' _

reports : al Alphonooataeee beeoocaebcntnnsnan nant a aniad Abe Abt lOO ADA DDO dl at Leiba hibited blee Besar ci ic ea aie ae aaa a ea eo a oe oe
esEe
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Tip «= You can also unmark a file by highlighting it and selecting

Unmark from the File menu. The effect is the same as selecting

the checkmark.

Starting the Backup

After you have finished marking files, you are ready to start the

backup. Select Start Backup from the File menu to start the backup.

mer Client: titania

Mark

Unmark /titania/rebecca/

Search...

——_—_—_ pe Start Backup...

1 7Do you want to compress this backup? | @ yes No

1 ?Do you want to exclude any patterns from this backup? oes @ No

In the Backup Options dialog box, you tell NetWorker whether you

want to compress your files during the backup. Compress the

files for this backup.
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Notice that Yes is highlighted after the question “Do you want to

compress this backup?.” ‘This means it is the default choice, so press

the Ok button to continue the backup with file compression.

NOTE: You can also exclude patterns in the Backup Options

dialog box. For information on excluding patterns, see

Chapter 4, “Backing up and Recovering Files.”

The Backup Status window appears, where you can monitor the

progress of your backup.

Backup start time: Wed Jun 23 11:14:54 1993

Aompressasm -s /home/titania/rebecca/pubs/doc2

compressasm -s /home/titania/rebecca/pubs/doc3
compressasm -s f/home/titania/rebecca/pubs/doc4

compressasm -s /home/titania/rebecca/pubs/dacs

compressasm -s f/home/titania/rebecca/spubs/docé
compressasm -s /home/titania/rebecca/pubs/doc?

compressasm -s shome/titania/rebecca/pubs/dace

compressasm -s /home/titania/rebecca/pubs/dacg
compressasm -s /home/titania/rebecca/pubs/dact?

compressasm -s fhome/titania/rebecca/pubs/docts

compressasm -s f/home/titania/rebecca/pubs/doct9

compressasm -s /home/titania/rebecca/pubs/doc20

compressasm -s fhome/titania/rebecca/pubs/docz
compressasm -s fhome/titania/rebecca/pubs/doc22

cutnressasm -s f#home/titania/rebecca/pubs/doc23

compressasm -s fhome/titania/rebecca/pubs/doc24

compressasm -s f#home/titania/rebecca/pubs/doc25
compressasm -s fhome/titania/srebecca/pubs/doc26

compressasm -s fhome/titaniafrebecca/pubs/
Backing up connecting directories...

fhome/titania/srebecca/
fhome/titania/
fhome/

save: fhomestitania/rebecca/pubs/ 6 KB 00:05:08 23 files
packur completion time: Wed Jun 23 11:20:03 1993

Tip «= If you do not see any files scrolling in the display, or if you see

an error message, contact your system administrator. The

server may be busy recovering, or it may have a configuration

problem. Or, the backup volume may not be mounted in the

device. You can check the Main window as described in the

next section to see if the backup volume is mounted.
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When your backup is complete, you will see a message similar to

this in the Backup Status window:

Backup Completion Time: Wed Jun 23 11:20:03 1993

NetWorker backed up the files you marked to the volume

mounted in the server device. It also created an index on the

NetWorker server for your client machine. Any files that you

back up in the future will have an entry in this index, so that you

can find them for quick recovery.

Select the Cancel button to close the Backup Status window.

Close the Backup window by selecting Exit from the File menu.

mer Client: titania
Mark

‘'titaniasrebecca,Unmark ftitania/yr cca,

Search...

Start Backup...

——_ t

If the scrolling list of your files does not appear in the Backup Status

window, or if you see an error message during the backup, you

can use the Main window to confirm that the backup volume is

mounted by checking the Pending display.

The Pending display of the Main window shows media requests for

backup volumes which are required for a backup or recover to

proceed.
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The Main window is shown below:

Server: atlas

Up since: Mon Jun 21 14:25:43 1993

Backups: 18 sessions, 350 MB total

Recovers: 0 sessions

"1 Devices:

qic Cunmounted) no tape label found

Sessions:

titania: /hame/titania/rebecca/pubs/ saving

Messages:

pritable backup tape

LN ILOILO EAI
Pending:

ool ‘Default’ waiting for 1 writable backuWed 10:40:28 media waiting: backup to

Pending —->

display

Notice the following message in the Pending display:

media waiting: backup to pool “Default* waiting for 1

writable backup tape

This message indicates that the backup volume is unmounted. If

there is no message in the Pending display, then the backup volume

is mounted and you can proceed with the backup.
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To avoid this media alert, it is recommended that you contact

your system administrator to mount a backup volume before

starting a backup.

Important > The backup volume must be mounted before a backup will

complete. For information on mounting backup volumes,

refer to the Legato NetWorker Administrator’s Guide.

Recovering a File

The index that is created on the NetWorker server when you back

up files is displayed in the Recover window. The index looks

similar to the filesystem that is pictured in the Backup window.

To recover a file, you browse the index for a directory and mark

a file within that directory. Then you start the recovery.

Opening the Recover Window

Open the Recover window by selecting Recover from the Operation

pull-down menu.

Operation

ed

‘Backup...

——_—Jp =sifecover...

Yoeertie er
P¥i ity ae yet

RPP RY ey

Volumes...
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The Recover window appears, as shown below.

File View

Server: atlas Client: titania

Browse Time: Wed Jun 23 11:22:45 1993

Selection: — tes | dhome/ti tania/rebecca/ a

=,

Senp f []
QO| -e pubs

O home

Q i titania

Oo - rebecca

una nenaos eee Sarr aseaaeeat aoe oN EE en pis Bic =
3

aaa
SanneSee

shanebarnnnnnsssnnnieansare
eae

Bavoneacnien honsnninnnroacnniannisanassniiannsannndSRB SRC2
Tip «= Remember that in the Recover window you are looking at the

index for your files on the NetWorker server, not the

filesystem on your system that is in the Backup window. The

Recover window shows the entries for those files that have been

backed up and are available for recovery. The entries are

organized exactly like the actual filesystem, so it is easy for

you to navigate around the directories.

38



Legato NetWorker User's Guide Quick Tour

Browsing the Index

You can browse the index to locate a file that you want to recover.

1. Notice that the current directory is highlighted.

eu

—__—___—__ > Level

Expand Branch

Client: titania

Browse Time: Wed Jun 23 11:22:45 1993

Collapse Branch

File Details

Show Marked

Versions...

afrebecca/

Tip "= Selecting a closed directory folder twice will also expand it

one level.

— = rebecca

aI plans

a pubs:

a! reparts

3. Highlight the directory folder that contains the desired file by

selecting it. The file display shows the most recently backed-

up version of the files contained in the directory.
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File View

Server: atlas Client: titania

Browse Time: Wed Jun 23 11:22:45 1993

Selection: —<—<—
Ahome/titaniasrebecca/pubs/Se ES SS aa ea ee ek EY

vee reery Si

‘-
doci? docié doci4 doc?

J [ O
doc2t) docz21 doce? dac2s

So far you have browsed the index and marked files for recovery.

You are now ready to start the recovery.
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Select Start Recover from the File menu. The Conflict Resolution

dialog box appears before the recovery starts.

Se ee eee
SEE Ee eee SEE SE ous

With the Conflict Resolution dialog box, you tell NetWorker what

to do if a naming conflict is encountered during recovery. A

naming conflict occurs when the file you are recovering has

the same name as a file in the current directory.

Select No so that NetWorker does not prompt you for each

naming conflict.

Rename the recover file is now highlighted as the default

selection. Rename the recover file places a .R extension after the

name of the recovered file when a naming conflict occurs with

an existing file.

Select Ok to close the Conflict Resolution dialog box and continue

the recovery.

Al
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Volumes needed:

001 at /dev/rmt/dn

Requesting 5 files, this may take a while...

Received 5 files from NSR server “atlas”

compressasm -r .fpubs/docd

./pubs/docé8: file exists, renaming to ./pubs/docd.R

compressasm -r ./pubsfdocd

./pubs/docd: file exists, renaming to ./pubs/docd.R

compressasm -r ./pubs/doces

./pubs/doc25: file exists, renaming to ./pubs/doc25.F

compressasm -r ./pubs/doc26

./pubs/doc26: file exists, renaming ta ./pubs/dac26.R
compressasm -r .,pubs/

Cancel} | Help |splat ean abate tn A MAAR BA DAA NDA DO LOND DS IAAL eb ABD Odo a ANE DO bal AUDA BEDE ANDES dM DRESANL ES ADN A t sonnunnuscnratnedar sian dued boidaheciissSoe rc aaa a are ate at ean a a ra ee a a enon Se a ae ea aC Naaer ater aah aaa a eae SRS
aaa ee Be

Se

SRA SS NSE SSS SS SESS Ee aE SSeS ENES

The Recover Status window provides information about your

recovery, including the name(s) of the backup volumes

(volumes needed: ) that are needed and their location, the

directory that the files are being recovered into, and the

number of files being recovered.

You may cancel the recovery by selecting the Cancel button in

the Recover Status window.

The following message appears when the recovery is

complete:

Received 5 files from NSR server ‘atlas*
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To confirm its recovery, you can look for your file in the

filesystem by listing the contents of the directory in a UNIX

terminal window. The recovered file has a .R file extension

because you told NetWorker to rename the file in the Conflict

Resolution dialog box.

Quick Tour Review

During the quick tour of NetWorker, you learned how to:

4) Use NetWorker’s graphical user interface.

(1 Use the Backup window to back up your directory to the

NetWorker server.

4 Monitor the status of your backup

Use the Recover window to browse the index for your backed-

up files.

Mark a file for a recovery in the Recover window.

Recover a file.

Resolve a naming conflict during recovery.Oo uo UU UO Monitor the status of the recovery.

The quick tour is meant to familiarize you with NetWorker’s

Backup and Recover windows. Chapters 3 and 4 provide detailed

information on performing backups and recovers.
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Chapier 3

Browsing Filesystems

NetWorker’s graphical user interface allows you to browse your

filesystems, including directories, subdirectories, and nested

files. Since the filesystem appears iconically on the screen, it is

easy to select files and directories for backup. When recovering

files, the index of saved files is displayed graphically like the

filesystem, making it convenient to select files for recovery.

NetWorker’s browsing features allow you to view directories,

mark and unmark files, search for files, view file details, and

change the current directory. The following instructions for

browsing filesystems apply to both the Backup and Recover

windows.

Viewing Your Directories

Use the View menu to select the level at which you wish to browse

the directories in the filesystem in the Backup window or browse

the index of directories in the Recover window.

NOTE: This section describes the features common to both

windows that are used for viewing directories. The features

specific to a window are described in Chapter 4, “Backing up

and Recovering Files.”

You can expand a directory to one level to view its subdirectories

or you can view all levels of a directory by expanding a branch.

This makes it easy to find files that are deeply embedded in your

filesystem.
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Expanding to One Level

Level

| Sel

Client: titania

Expand Branch

- afrebecca/
Collapse Branch [2 ~

File Details

To expand a directory to one level:

1. Highlight a directory folder in the directory display.

2. Select Expand One Level from the View pull-down menu.

| File Wew

Server: atlas Client: titania

Selection: | Phome/titania/rebecca/ : |

aL] ol] QO
_ plans pubs reports

ot home

Q i titania

O _ rebecca

oO | plans

pubs

. ~

a] reports
SSR eC a Re Ra
SERRE ene eee eee ee ee ee ean een neces nanan as ea nee Rg eee CER enemas

46



Legato NetWorker User’s Guide Viewing Your Directories

Expanding a Branch

Level
Client: titania

Expand Branch

- afrebecca/Collapse Branch be
File Details

1. Highlight a directory in the directory display.

2. Select Expand Branch from the View pull-down menu.

File Wiew

Server: atlas Client: titania

Selection: | {home/titania/rebecca/

rebecca = =ae al_] oC] olL_]
plans pubs reports

i lans .Q P

= q3p] ansa aR eet oa3ua_— a>ia

i
3

RS RRRa ae OMe

47



Viewing Your Directories Legato NetWorker User's Guide

Collapsing a Branch

Level
Client: titania

Expand Branch

Collapse Branch

File Details

a/rebecca;

To collapse a branch:

1. Highlight an expanded directory in the directory display.

2. Select Collapse Branch from the View pull-down menu.

File ‘ew

: Server: atlas Client: titania

|| Selection: |
Ahome/titania/rebecca/

= , ~,

i Pr) old oo
, reports

gk home

oO / titania

oO a rebecca
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Marking and Unmarking Files

You choose files and directories for backup and recovery by

marking them. The icons have a checkbox beside them that

displays a checkmark when the file is marked. You can mark or

unmark files and directories by using either the File pull-down

menu or the checkbox.

To mark a file or directory using the File menu:

1. Highlight a file or directory icon by selecting it with the

mouse.

2. Select Mark from the File pull-down menu.

ile} View

rver Client: titania

Mark

Unmark /titania/rebecca/

This places a checkmark in the checkbox beside the

highlighted icon to mark it for backup or recovery.

3. If you decide that a file should not be included in the backup

or recovery, highlight the icon and select Unmark from the File

pull-down menu to remove the checkmark.
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Tip «=

To mark a file using the checkbox:

1. Use the mouse to select the checkbox next to the file. This

places a checkmark in the checkbox.

2. Select the checkmark to unmark the file.

el] ts

When you mark a directory, all its subdirectories and nested

files are also marked. The checkboxes of the parent

directories turn grey to indicate that some or all of the

directory contents are marked for backup or recovery.

Viewing File Details

50

NetWorker lets you choose to view the file details or only the file

names in the file display. File Names is the default selection. File

Names lists the files in alphabetical order with only the filenames

displayed. File Details displays the filename, number of blocks,

permissions, number of links and where they point (only applies

to symbolic links), owner, group, size, and date last modified for

each file.

Backup File Details and Recover File Details are identical except for one

difference. Recover File Details provides the backup time for each file

to identify different backup versions of the same file.

Use the View pull-down menu to select either the File Names or

File Details in the file display. File Names/File Details is a toggle

selection. When you are in File Names mode, the menu selection

changes to File Details. When you are in File Details mode, the menu

selection changes to File Names.
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To display the file details:

1. Select File Details from the View pull-down menu.

2. Adjust the size of the window to display the full File Details.

Level Client: titania
Expand Branch Browse Time: Tue Sep 21 12:18:36 1993
Collapse Branch

———__ file Details af rebecca/pubs,

Show Marked

View Helpq File

Server: atlas Client: titania

Browse Time: Tue Jul 6 09:59:42 1993

Selection: ——
| {home/ti tani a/rebecca/pubs/

Backup time: Jum 24 18:26— 4 1) Q-ru-ru-r-- Lornagon wheel 0 Jun 22 1732654 |;
docl3 mE

i hone a@ s

I
F

Backup time: Jun 23 11:14 -
Q -rw-rw-r-- 1 rmason wheel 0 Jun 22 17326 -

docl?

Backup timer Jum 23 1isid a

0 0 -recrucr-- Ll rmason wheel QO Jun 22 17:26 ‘

docid

Backup time: Jun 23 lisd4 OE
GO -ru-rw-r-- Lo rmason wheel 0 Jun 22 17:26 : a:

docl3
af
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Searching for Files

If you know the name or partial name of a file or directory, you

can use the Search window to locate it in the filesystem or index.

To search for files, you specify the filename or partial filename

you are looking for and the directory name where you wish to

begin the search. NetWorker begins searching in that directory

and then searches through its subdirectories and nested files.

To search for files or directories by name:

1. Use the File menu to open the Search dialog box.

2. Enter the name of the file or directory in the Search for field.

You can use standard UNIX shell pattern characters when

specifying partial filenames.

* doc

egin search in: |. a ssBeg arct | ‘home/titania/rebecca/

3. Enter a valid pathname of the directory where you wish to

begin the search in the Begin search in field. NetWorker searches

through that directory and all nested subdirectories.

4. Select the Ok button. The pathname of the first match appears

in the Selection field and is also highlighted in the file display.

5. Select the Continue button to highlight the next match.

You can continue the search until the last match is found.
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Changing a Selection

The NetWorker windows display the full pathname of the current

directory in the Selection field. If you know the path of a directory

or file, you can go directly to it by entering the full pathname in

the Selection field.

Selection:
Ahome/ti tania/rebecca/

To change the current selection:

1. Enter the full pathname in the Selection field.

2. Press the [Return] key.

Both the directory and file displays change to show the new

selection.

Exiting from a Window

The Exit command is in the File menu of every window. Exit closes

the current window without backing up or recovering files and

returns you to the Main window.

rver
Client: titania

Mark

Unmark

Search...

Start Backup...

ftitania/rebecca/

—————_ i txit

Select Exit from the File menu to close the window.
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Chapter 4

Backing up and Recovering Files

This chapter describes NetWorker’s Main, Backup, and Recover

windows. It includes the backup and recover functions that are

unique to each of the windows. For information on using the

functions that are common to the windows such as viewing and

marking files, see Chapter 3, “Browsing Filesystems.” For a

quick tour of NetWorker’s Backup and Recover windows, see

Chapter 2, “Getting Started.”

Monitoring Your Backup and Recovery

Tip «=

NetWorker'’s Main window monitors your backups and recovers.

(It also provides pull-down menus for selecting the Backup and

Recover windows.) The Main window provides valuable on-line

information about server status, backup device status, client

sessions, and pending requests.

The Main window appears when you invoke NetWorker.

Keep the Main window open during every backup or recover

to monitor the progress of the session.
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Menu ——_—__y»

bar

Server ——_y>»

status

display

Devices ——>>

display

Sessions ——p>

display

Messages —y»

display

Pending ——»>

display
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The NetWorker Main window is shown below:

a File Operation Administration

Server:

Up since:

Backups:

Recovers:

talus

Tue Bec 14

( sessions

QO sessions

eU;30°26 1933

NetWorker 4.0/1

Sessions:

Messages:

Pending:

Resize —
button

The Main window has a Menu bar and five displays:

1) Menu bar- contains the File, Operation, Administration, and Help pull-

down menus.

i Server status display — tells you how long the current server has

been on-line, the number of backups and recovers the server

has completed since it has been on-line, and the amount of

data contained in the backups and recovers.

Devices display — shows you the backup devices known to the

server and which volume, if any, is mounted in the device.
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1 Sessions display — provides current information on which

clients are backing up, browsing, or recovering files.

4 Messages display — provides a history of the NetWorker server

activity.

11 Pending display — shows messages that may require operator

attention.

A scroll bar appears to the right of the display area when there is

more information to see. Use the resize buttons for resizing the

display areas.

Backing up Files

This section assumes you have already marked your files for

backup. If you need to know how to view directories, mark files,

search for

files, or view file details, see Chapter 3, “Browsing Filesystems.”

Changing the NetWorker Server

NetWorker clients are included in a scheduled backup

determined by your system administrator.

Generally only one NetWorker server is required to back up all

the systems on a network. If you have more than one NetWorker

server on the network you may have a choice of servers.

However, you must be listed as a client on the NetWorker server

you choose for your backups. Check with your system

administrator if you wish to back up to a server other than the

server chosen for your scheduled backups.

o/
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You may need to back up a file to a different server due to

network difficulties or because your backup server is down.

To change NetWorker servers, follow these steps:

1. Select Change Server from the File pull-down menu.

File

——_ Change Server...

Change Polling...

Exit Cteol-x

The Change Server dialog box appears, as shown below.

Server: [atlas so

a

re: a
4 oe

. oy

ae |
4 sd

<

caelum

fUpdate Server List}Breanna acshat tabbed nein bi etna aU at Nt aL ane DA ta tt iieee rear i
a4

ich Patuaararanens ont cmremremre emer meme ee ee eSeee a eSATA prea

ok | icancel{ Help |

oS

2. Select the Update Server List button to update the list of

NetWorker servers on the network.

3. Highlight the hostname of a server, or enter a valid hostname in

the Server field.

4. Press Ok to choose the new server.
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NOTE: If you choose a NetWorker server that does not have

your system listed as a client, you will receive an error message,

as shown below.

Starting a Backup

Before starting a backup, complete the following steps:

“1 Mark the files that need to be backed up.

“1 Choose the NetWorker server (if necessary).

When these steps are complete, you may start the backup.

ile | view

ryver
Client: titania

Mark

Untark
ftitania/rebecca/s

Search...

_iStart Backup...

exit
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Choosing the Backup Options

NetWorker displays the Backup Options dialog box before starting

the backup. Backup Options gives you the option to compress files

and exclude patterns before the backup starts.

Compressing Files

To choose whether or not to compress the files you back up,

answer the question “Do you want to compress this backup?” in the Backup

Options dialog box. Notice that Yes is already highlighted as the

default selection.

NetWorker requires that you choose whether or not you want to

compress your files in the Backup Options dialog box, before you can

back them up.

Do you want to conpress this backup?
@ es GNo

1 ?Do you want to exclude any patterns from this backup? Qves No

Pattern: | $ia roo ma
Eres besebaeoetaes Beene NS ee NS cS RR

To continue the backup with file compression:

Since Yes is the default selection, you do not have to make a

selection to continue the backup with file compression.

To continue the backup without file compression:

Press No to continue the backup without file compression.
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Tip = It is a good idea to compress all your backups to save space

on the backup volumes and to reduce network

traffic. However, backups may be slower due to

compression.

If you do not need to exclude patterns from your backup, press

Ok to continue the backup with your file compression choice.

Excluding Patterns

Before starting a backup, you can exclude patterns in the Backup

Options dialog box. To exclude patterns, you specify

alphanumeric patterns that occur in the names of the files that

you want to exclude from the backup. Any number of patterns

may be specified using UNIX shell pattern characters.

Excluding patterns is an optional shortcut for eliminating similar

files from the backup.

Notice that No is highlighted as the default answer to the

question “Do you want to exclude any patterns from this backup?.” If you do

not wish to exclude any patterns of filenames from the backup,

select Ok to continue the backup with only your file compression

choice.

To exclude patterns from the backup:

1. Select Yes to answer the question “Do you want to exclude any patterns

from this backup?.” ‘This activates the exclude patterns portion of the

Backup Options dialog box.

2. Enter the first pattern to be excluded in the Pattern field.
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3. Select Add to add the pattern to the pattern list.

sees Sint prikiarcran ns nsaonanaens Savona eotui sents pnuritonban aan nnnenngons sonny sacra Nay aie ss

¢ Do you want to compress this backup? . :
. ’ P n @ Yes GNo 4

: Do you want to exclude any patterns from this backup? @ Yes ONo

Pattern: | te a
:pew PEP ROVER EON sd

ok ‘Hel :rnJ eMeip x

*

a
erecnerantetitatann eee heat ec tannen at Ken aawtatenuvintineonenenen seven nemo eM Renee OR RY bee eee Neer raceme er anneannarencmnter nena i Prete ore rararatane natoad Satan ne ena chetan Mee LANL emt a ND is ee

FR RR eee RE ENC eRe Me

4. You may enter any number of patterns and add them to the

pattern list.

If you wish to change a pattern, select it in the pattern

list. The selected pattern appears in the Pattern field. Enter the

new pattern and press Change. The new pattern replaces the

old pattern in the pattern list.

5. To delete a pattern, select it in the pattern list and press Delete.

6. Select Ok to continue the backup with the excluded patterns.
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Monitoring the Backup Status

After you press Ok to complete the Backup Options dialog box, the

Backup Status window appears. Use the Backup Status window to

monitor the progress of the backup.

compressasm

compressasm

fhome/titania/rebecca/pubs/doct?
fhomestitania/rebecca/pubs/doct8

sf} a Backup start time: Wed Tun 23 11:14:54 1993 -
a compressasm -s fhome/titania/rebecca/pubs/doc2

| gcompressasm -s /home/titania/rebecca/pubs/doc3

oq comipressasm - fhome/titania/rebecca/pubs/doc4
sq compressasm -s /home/titania/rebecca/pubs/docs

fod compressasm -s /home/titania/rebecca/pubs/docb
se jd compressasm -s /home/titania/srebecca/pubs/dac?

| dcompressasm -s /home/titania/rebecca/pubs/docd
| i compressasm -s /home/titania/rebecca/pubs/docd

compressasm

compressasm

fhome/titania/rebecca/pubs/doci9
fhome/titania/rebecca/pubs/doc20

compressasmt fhome/titania/rebecca/pubs/doc2
compressasm -s /home/titania/rebecca/pubs/docz2

compressasm -s /home/titania/rebecca/pubs/doc23

compressasm -s /home/titania/rebecca/pubs/doc24

compressasm -s /homestitania/rebecca/pubs/doc25

compressasm -s /home/titania/rebecca/pubs/doc26

compressasm -s /home/titania/rebecca/pubs/
Backing up connecting directories...

fhomestitania/rebecca/
fhome/titania/

fhome/

WA a UL oe RA LA onpeheeannnnannnn aintse aan

‘s

!

save: /home/titania/srebecca/pubs/ 6 KB O00:05:0
q

§ 23 files
Backup completion time: Wed Jun 23 11:20:03 1993

e wo
: Helpcancel

Saar ena aaa A ACN Ai NN NWA AME NASAL COMA
SR ee ee ee SA ree ey ieee

The Backup Status window provides the Backup start time and

the Backup completion time. The names of the files and

directories scroll across the Backup Status window as the backup

proceeds. The save message at the bottom of the window gives

you information about the backup including the full pathname of

the directory and the number of kilobytes and files being saved.

You can cancel the backup by pressing the Cancel button.
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The following message appears in the Backup Status window when

the backup is complete:

Backup completion time: Wed Jun 23 11:20:03 1993

Using the Volume Management Window

You can verify that NetWorker has successfully backed up your

files in the Volume Management window by selecting the Volumes

command in the Operation pull-down menu. You can determine

exactly to which volumes your files have been backed up. All of

the volumes known to the NetWorker server are listed in the

Volumes scrolling list, and the contents are listed in the Save Sets

scrolling list.

aE Yo] ume Help

/ Nane Pool ¥ritten % Use Mode Location
Matias. 007 -1 CE cde ag tS

: atlas.002 Default 1% appendable

: atlas. 003 Default 224 KB full recyclable

-

/

|

- Client Date Level Status Path

| Save Sets: SE a eee
. atlas 7/15/93 q retrievable bootstrap

e atlas 7714/93 full retrievable /nsr/index/atlas

S atlas 7/14/93 full retrievable /usr/sre/sca

e atlas 7/14/93 full retrievable /usr/u

B atlas 7/14/93 full retrievable = /nsr

/ atlas 7/14/93 full retrievable /
s atlas 7/14/93 9 retrievable /fnsr/index/atlas

- atlas 7/14/93 9 retrievable bootstrap

: atlas 7/15/93 full retrievable /nsr/index/mars

. atlas 7/15/93 incr retrievable fusr/sre/sco

i 7/19/93 full retrievable /nsr/findex/titania

eivnneneend Spacey nies ett ee cas cee Pee ee eee ESR eRe EN eee

When you select the name of a volume in the Volumes list, the Save

Sets list displays the contents of that volume. In the example
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above, the file boot strap has been backed up on the volume

atlas.00l1.

NOTE: The information listed in the Volume Management

window is useful to the system administrator for managing

NetWorker’s backup volumes.

Recovering Files

This section assumes you have already marked your files for

recovery in the Recover window. If you need to know how to view

directories, mark files, search for files, or view file details, see

Chapter 3, “Browsing Filesystems.”

The files listed in the Recover window are entries for the files that

were backed up by NetWorker. When NetWorker backs up a

file, it creates an entry for the file in the on-line index. You may

then select a file that is listed in the index for recovery.

NetWorker’s powerful recover functions allow you to browse

the index for previous backups, select various versions of the file

to recover, view your marked files, relocate files upon recovery,

and recover files from another authorized system. An

“authorized system” is a client from which you have permission

to recover data.

Choosing the Recover Server |

Normally you recover files from the NetWorker backup server

chosen for you by your system administrator. If you have

backed up files to a different server, you must also recover those

files from that server. If you changed servers in the Backup

window, select the same server in the Recover window.

The Change Server dialog box lists all the NetWorker servers on the

network. You can only recover files from a server that lists your

system as a client.
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To choose a recover server:

1. Ifitis not already open, select Recover from the Operation pull-

down menu to display the Recover window.

2. Select the File pull-down menu and then choose the Change

Server command. The Change Server dialog box appears, as

shown below.

a File Miew

| Server: atlas

Use the Update Server List button to update the list of NetWorker

servers on the network. Choose the server that has the files

you need to recover. The Server field changes to reflect the

current selection. The directory and file displays are

refreshed to show the index for the current server.

3. Press the Ok button after you have selected a server.

Choosing the Recover Client

If you need to recover files from a client other than the system

you are currently using, use the Change Client command in the File

pull-down menu. The Change Client command opens a dialog box
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which lists all of the NetWorker clients. Check with your system

administrator if you wish to recover files other than your

own. You may not be authorized to recover files for other client

systems.

To choose a recover client:

'| Server:

| Client: | titania

mt

titania

fUpdate Client List aged ieee eno ene natant nen eet rN Nee eee oe isaac ie Nas ae a oe a| Ok | iCancel| Help |

SSS SA Caracas naar nanar nen ae

You can update the list of NetWorker clients by selecting the

Update Client List button.

2. Choose a client from which you are authorized to recover

files. The Client field changes to reflect the current selection.

Selecting File Versions

The Versions window lists all the versions of a file or directory that

have been backed up by the backup server. It also lists the

6/
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location of the versions. Use Versions to view the backup history of

a file and to mark a version for recovery.

Versions of a directory may be listed in the Versions window, but

directories cannot be marked for recovery in the Versions window.

Only versions of files may be marked for recovery in the Versions

window.

The Versions window provides the following information about

each version: number of blocks, mode, permissions, number of

links, owner, group, size in bytes, last modified time, and

filename.

It also provides the backup time and location of the version. The

backup time is used to identify different versions of a file.

The location includes the name of the backup volume, the device

where the volume is mounted, if any, or the location of the

backup volume (for example, an off-site storage place). If no

device is listed, it means that the backup volume must be

mounted before recovery of the file is possible.

The information in the Versions window is retrieved from the index

that is created by NetWorker when you perform a backup.

To view the backup history of a file or directory:

1. Open the Recover window and highlight a file or directory in

the file display.
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2. Select Versions from the View pull-down menu.

Expand Branch Browse Time: Tue Sep 21 12:31:38 1993
Sel Collapse Branch

File Details a/rebecca/pubs,

Show Marked

—_—_ fr versions...

NetWorker retrieves ten versions of the highlighted file or

directory from the index and lists them by backup time,

beginning with the most recent. Use the scroll bar to view the

backup history.

. Backup time: Jun 24 19226 Location: 001 at /dev/rmt/on
a O 0 -ru-ru-r-- 1ormason wheel QO Jun 22 17326

Backup times Jun 24 18122 Location: 001 at fdevsrmt/on

Q 0 -rw-ru-r-- 1 rmason wheel O Jun 22 17226

S Backup time: Jun 24 18:19 Location: 001 at fdev/rmt/dn
gO Oo -rw-ru-r-- do rmason wheel O Jun 22 17226

Backup time: Jun 24 18:15 Location: 001 at fdev/rmt/On
Q Q -rpw-rw-r-- lo rmason wheel G Jun 22 17:26

Backup time: Jun 24 18:11 Location: O01 at fdeyv/rmt/On

Q GO -rw-rw-r-- do rmason wheel QO Jun 22 17226

icancel |
ke
CERNE SD RAAR DIDS CRISIS YDSO HEME a

ed fen nea

3. Press More to retrieve ten more versions from the index. The

More button turns to grey when all versions have been

retrieved.
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Important ~ Remember, you cannot mark directories for recovery in the

Versions window. Use the Change browse time command in the File

pull-down menu to mark a past version of a directory for

recovery.

To select a version of a file for recovery:

1. Select the checkbox of the version that you want to recover.

2. Select Ok to place the checkmarked versions in the file display.

Tip «== When you mark a past version of a file in the Versions window,

this version appears in the Recover window file display with

the same name as the recent version. You will then have more

than one version of a file in the file display. If you are

confused as to which version to mark, use File Details to display

the backup times.

Changing the Browse Time

The Browse Time field displays the current date unless you change

it to a date in the past. The currently selected browse time is

indicated in the Browse Time field in the Recover window.

as sesance ata ance

File View

|) Server: atlas Client: titania

Browse Time: Wed Jun 23 14:22:32 1993

a Selection: ~* va- | ‘home/titania/rebecca/pubs/doct 3Broul

In the Recover window you are viewing the index entries for

previously backed-up files. Changing the browse time displays

the index entries for files backed up at that time.
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Tip «= If files were not backed up at the time entered in the Browse

Time field, NetWorker displays files that were backed up

closest to the selected browse time.

Changing the browse time lets you view your files as of some

time in the past. This is useful if you do not remember the name

or location of the files you want to recover, but you remember

they existed at some time in the past. Change browse time also helps

you find files that have been deleted and thus do not appear in

the Versions window. You can recover deleted files by changing

the browse time to locate past versions of the files in the index.

Important > You can mark directories for recovery in the Recover window

by using the Change browse time command rather than the Versions

command.

To change the browse time to recover a past version of a file:

1. Open the Recover window and select Change browse time from the

File menu.

Change Server Client: titania
c “13 ; ;

Change Client Browse Time: Wed Jun 23 14:22:32 1993
a: Mark

4) Unmark nia/rebecca/
secur mechan rane ata coat

Search...

——Je change browse time...

] Relocate...

| Start Recover...

7
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2. The Change Browse Time dialog box appears. The Prev, Today, and

Next buttons control the month shown in the calendar. When

the desired month is displayed, select the browse time by

selecting a day in the calendar.

ae

SERRE RE OOO EA ER Oa SOE TUSSI SO
39:59 1993

SIG LA CON

3. Youcan also enter the date and time in the Browse time field and

72

press [Return] to change the browse time. The following

formats are valid for browse time:

hh:mmiss (24 hour clock) or hh:mm (am,pm)(PDT)

mm/dd/(yy) or monthname dd (yy)

last Friday, next Friday, third Friday

+ or - 3 seconds, minutes, hours, weeks, months, years

Press Ok to display the files that were backed up at the new

browse time. The Browse time field in the Recover window

changes to reflect the new browse time. Both the file display

and the directory display of the Recover window show the files

that were backed up at that time. You may now mark past

versions of files for recovery.
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NOTE: Any files or directories that you have marked for

recovery prior to changing the browse time will remain

marked.

Showing Marked Files

You can list the files you have marked for recovery by selecting

Show Marked. Use Show Marked to check which files you have marked

for recovery before performing the actual recover. The Files Marked

for Recovery window lists the pathnames and backup time of files

that you have marked for recovery.

To show the files that you have marked for recovery:

1. Select Show Marked from the View menu of the Recover window.

Level Client: titania

Expand Branch Browse Time: Tue Sep 21 12:31:38 1993
Collapse Branch

File Details afrebecca/pubs,

———p show Marked

Versions...

Sel
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The Files Marked for Recovery window appears, listing the

pathnames and backup time of all marked files.

92. Press Cancel to close the window.

Ree

fhomestitania/rebecca/pubs/docl3 @ Thu Jun

fhomestitania/rebecca/pubs/doct3 @ Thu Jun

fhome/titaniafrebecca/pubs/doci3 @ Thu Jun 2
/home/titania/rebecca/pubs/dact3 @ Thu Jun

4 files marked for recovery

Relocating Files

Use the optional Relocate command before you start a recovery to

place your files in a directory other than the original one. Relocate

first creates the directory if it does not already exist and then

stores the recovered files in the new directory. You may also

relocate files to an existing directory by entering the complete

pathname.
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To relocate recovered files into a new or existing directory:

Lnane ver Client: titania

~*~ Browse Time: Wed Tun 23 14:22:32 1993

ninark niasrebecca/ SE SORE OESEe aPC ERS
Change browse time...

Relocate...

Start Recover...

Exit SAA RONAN

2. Enter the name of the directory where the recovered files will

be stored in the Relocate to field. You can relocate files to anew

directory or to an existing directory. Be sure to include the

complete pathname.

Relocate to: | reports]

3. Select Ok to relocate files into the new directory.

ih



Recovering Files Legato NetWorker User's Guide

Starting a Recovery

Before starting a recovery, complete the following steps:

Choose a server and an authorized client, if necessary.

Mark files and directories for recovery.

Select a past version of a file by name and location if desired.

Select a past version of a file by browse time if desired.

Show your marked files if desired.oOo oO oO oO OO U Relocate recovered files to a new directory if desired.

Usually, you can complete a recovery in two steps: mark the files

and start the recovery.

File View

Change Server Client: titania

Change Client Browse Time: Wed Jun 23 14:22:32 1993
Mark

]: Unmark nia/rebecca/

Search...

Change browse time...

Relacate...

eStart Recover...

| exit PREDOMI AEP OOP DELLE DEEP ET EE ED PEDDLE LEONI INS
Before actually starting the recover process, NetWorker prompts

you for instructions on how to resolve naming conflicts by

displaying the Conflict Resolution dialog box.
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Renaming or Overwriting Recovered Files

With the Conflict Resolution dialog box, you tell NetWorker whether

to rename recovered files or overwrite existing files when a

naming conflict occurs. A conflict occurs when a file you are

recovering already exists or has the same name as one in the

current directory. The Conflict Resolution dialog box has two

questions for you to answer concerning conflicts between

recover files and existing files.

1. Toresolve the conflict, first answer the question, “Do you want to

be prompted when conflict occurs?.” If you select No, then you specify

a global resolution for renaming or overwriting files, in the

Conflict Resolution dialog box, shown below.

a@miiiet groures, Net@erker shanid? . os ¢> HORE Ae OF Fes ov eee
PSAVTESAnDSE OUOGE ob are ata

OM De ho teta ceengrescces ee ord tas
fei tees bog Ripe Daya. ig rodobay

: :: eel Lyaed ‘
rs eer Fae cD ie Tite os “UOT Rte

z Ok] Help|

2. If youselect Yes, the default selection, NetWorker will prompt

you for instructions in the Filename Conflict dialog box every

time it encounters a conflict between a recovered file and an

existing file. For each recovered file that is in conflict with an

existing file, you tell NetWorker whether to rename the

recovered file, discard the recovered file, or overwrite the

existing file. This allows you to resolve conflicts on a file-by-

file basis.
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The Filename Conflict dialog box is shown below:

Ne ee

ame Conflict. for ,/“dacise

# Rename the recover file

: yY Discard the recover file
a

=
% Qverwrite the existing file

Do you want to be prompted if further conflicts occur?= NOR arama ryan serene

3. If you select No, then you must answer the question “When

conflict occurs, NetWorker should?.” Answering this question allows

you to resolve conflicts on a global basis per recover session

without being prompted for each individual file.

ronflict. Resolutions

. . . >When conflict occurs, NetWorker should? 4 Rename the recover file

vy Discard the recover file

¢%Y Gverwrite the existing file

ANNAN A AE EI AR AEN NI EI RR LAN a a OE CO LLNS aE PENNS DREN hen a eC REE EEeeET e E SeeSERS RSS GCE SSS SERRATE SRS SIS SE
rat

Select one of the following to solve conflicts:

Rename the recover file - When a conflict occurs, NetWorker

renames the recover file with a .R extension. If the -R file

exists, NetWorker adds another .R.

Discard the recover file - NetWorker discards the recover file. The

existing file remains current.
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Overwrite the existing file - NetWorker replaces the existing file

with the recovered file. The existing file is lost and the

recovered file becomes current.

4, After completing the Conflict Resolution dialog box, select Ok to

continue the recovery.

Monitoring the Recover Status

After the Conflict Resolution dialog box closes, the Recover Status

window re-appears as the recovery continues.

cover Statuses

oa Volumes needed:

001 at fdev/rmt/On

Requesting 5 files, this may take a while...

Received 5 files from NSR server “atlas*

compressasm -r ./pubs/doc8

./pubs/dacé: file exists, renaming to ./pubs/doc8.R

caompressasm -r .,pubs/docd

./pubs/docd: file exists, renaming to ./pubs/docd.R

compressasm -r ./pubs/doc25

./pubs/doc25: file exists, renaming to ./pubs/doc25.R

compressasm -r ./pubs/doc2é

.fpubs/doc26: file exists, renaming to ./pubs/doc26.R

compressasm -r ./pubs/

aa ania

SS on UR ROSEN SON AEN
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The Recover Status window provides you with the following

information about your recover session:

LJ The name of the required backup volume and its location.

Volumes needed:

.001 at /dev/nrStpod

The pathnames of the files being recovered and the pathname

of the directory where they will be stored.

/home/titania/Rebecca/pubs/ is being recovered into its

Original location

If you specified a directory in the Relocate dialog box, it will be

listed after “...is being recovered into...”

If you chose to rename the recover files, the new filenames are

listed.

The number of files it is recovering.

Requesting X files, this may take a while...

As the recovery proceeds, the pathnames of the files scroll

across the Recover Status window.

When the recovery is complete, the following message appears:

Received X files from...

Press Cancel to cancel the recovery.

Press Cancel to close the Recover Status window.
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Chapter 4 has given you a thorough overview about how to back
up and recover your NetWorker files. You have learned how to:

Back up files

Monitor the backup status

Use the Volume Management window

Recover filesCb ou UU OU oO Monitor the recover status

For more information about configuring the NetWorker server,

refer to the Legato NetWorker Administrator's Guide or ask your

system administrator.
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Appendix A

Error Messages

NetWorker provides user-friendly error messages that have easy

to understand explanations. This appendix provides you with

further information and solutions to assist you with your

backups and recovers.

Error Messages for Backup

NetWorker displays an error message if a backup cannot be

successfully completed. NetWorker backup error messages are

shown below:

Message: Nothing marked for backup

Problem: Starting backup without marking any files.

Solution: Mark at least one file before starting the backup.

Message: Unable to start backup

Problem: Error starting the backup (could not execute the

Solution:

Save command).

Contact the system administrator. There is a

problem with the NetWorker software or there is a

problem with the configuration (for example, an

incorrect path name.
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Message:

Problem:

Solution:

Your system is not a registered client.

The server you have chosen to do your backups does

not have your system configured as a NetWorker

client.

Contact the system administrator. Your system

needs to be added to the server's list of recognized

clients.

Error Messages for Recover

An error message is displayed when NetWorker is unable to

successfully recover a file. NetWorker recover error messages are

shown below:

Message: There are files marked for recovery.

Continue to ignore the marked files,

Cancel to stay with this client.

Problem: Changing clients when files are marked.

Solution: You have the option to continue changing clients.

In this case, the marked files will not be recovered.

Or you can cancel to stay with the current client and

retain your marked files.

Message: (For root user) Only 10 KBytes available to non-

superusers (15 KBytes free) in /home/server_name.

Filesystem will be greater than 100% full after recover

is complete.

Proceed with recover command at this time? [n]

(For a non-root user) No disk space available to non-

superusers (15 KBytes free) in /home/server_name.

The estimated recover size of 10 KBytes will not fit
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on this filesystem.

Proceed with recover command at this time? [n]

Problem: There is not enough free space in the filesystem to

recover the requested files.

Solution: Reduce the number of kilobytes in the recovery by

reducing the number of marked files. Relocate the

recovery into another directory with more space. If

you are recovering over existing directories, you

may be able to proceed with the recovery since files

will be overwritten.

Message: Invalid time format

Problem: The time specified in the change browse time field

was invalid.

Solution: Enter the browse time using a valid format.

Examples of valid time formats are:

hh:mm:ss using the 24 hour clock

hhmm (am, pm) (PDT)

mm/dd/yy or monthname dd yy

last Monday, next Monday, 1st - 12th Monday

now, yesterday,

+ or - 3 seconds, minutes, hours. weeks, months,

years

Message: Nothing in index at this time

Problem: There are no entries in the index for the browse

time that was specified. No backups were

performed

at that time.
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Solution: Enter another browse time close to this one until you

find the index entries you are looking for.

Message: Unable to relocate to /usr/tmp/root

Problem: NetWorker was unable to relocate to the specified

path.

Solution: Enter a valid pathname in the Relocate dialog box and

start the recovery again. You must have write

permission for the directory you wish to use.

Error Messages for both Backup and Recover
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some of NetWorker’s error messages are the same for both an

unsuccessful backup or recover. The error messages used for

both backups and recovers are shown below:

Message:

Problem:

Solution:

You cannot mark files from different filesystems.

/home/quattro/rebecca/docs/1lusr.doc is on a

different filesystem from files you have already

marked. You must either Backup or Recover the files

you have marked or unmark them before you can

mark this file.

NetWorker does not allow you to mark files across

filesystems.

Complete the backup or recovery for one filesystem

at a time.

Message: There are files marked for backup or recovery.

Continue to ignore the marked files or

Cancel to stay with server.
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Problem: You cannot change servers after you have marked

files.

Solution: You have the option to continue changing servers.

If you change servers, the marked files will not be

backed up or recovered.

You can cancel to stay with the current server and

retain your marked files.

Message: Bad start path

Problem: Specifying an invalid starting path for a search.

Solution: Enter a valid pathname as a starting point in the

search dialog box.

Message: No match

Problem: Nothing matched on this search command.

Solution: Enter a different pattern or a different starting path.

Message: Bad search pattern

Problem: The search pattern specified is not valid.

Solution: You may use the UNIX shell pattern characters to

specify a search pattern.

Message: Unable to expand path

Problem: The path specified in the selection field does not

correspond to anything in the index or filesystem.

Solution: Enter a valid pathname in the selection field.
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Appendix B

Commands for Backup and Recovery

In addition to a graphical user interface, NetWorker has UNIX-

like commands for performing backups and recovers. These

commands are entered from a UNIX shell. To use the NetWorker

commands from a UNIX shell, the NetWorker software must be

installed on the NetWorker server and your system must be

configured as a NetWorker client by the system administrator.

Table of Backup and Recover Commands

Use the save command to back up data. The backup and recover

commands are listed below. Except for nsrwatch, recover -c, and

save, you can use these commands after entering recover at the

system prompt.

Command Description

add filename add filename to the recover list

cd dir change directory to dir

changetime change the browse time of on-line index

delete filename delete filename from the recover list

dest verify destination directory for recovered files

force overwrite existing files

help or ‘?’ display list of recover program commands

list list the files in the recover list

Is -F filename list filename with file type information

Is -l filename list filename using long format

Is filename list filename

noforce do not overwrite existing files

nsrwatch monitor NetWorker server activity
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Command _ Description

pwd

quit

recover

recover -c

client_name

relocate dir

save pathname

verbose

versions filename

volumes filename

display name of current directory

exit the recover program

start the recover program when entered at the system

prompt; start the recovery when entered at the recover>

prompt

browse the index and recover files for the specified client

specify new directory location for recovered files

starts a backup of the current directory, or enter pathname

toggle verbose or quiet mode for recover status messages

display backup history of file filename

filename can be either a file or a directory

list volumes needed to recover marked files

filename can be either a file or a directory
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Requirements for NetWorker Clients

Your system administrator is responsible for setting up the

requirements for NetWorker clients.

The following three conditions must be met for a workstation to

qualify as a NetWorker client:

O The NetWorker software must either be NFS-mounted from

each client, or installed on a local disk. For directions on

how to install NetWorker, see the NetWorker release notice

and Managing the DG/UX System (093-701088).

(1 The daemon nsrexecd, used by savegroup to start saves, must

be running on each NetWorker client.

1 The NetWorker server must be configured to recognize each

of its clients, as explained in Legato NetWorker Administrator's

Guide.

If any one of the above conditions is not met, you will be unable

to use NetWorker. Contact your system administrator for a

remedy.
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Glossary

This glossary contains terms and definitions found in this

manual. Most of the terms are specific to the Legato NetWorker

product.

back up

backup media

collapse

index

expand

media device

NetWorker client

The storing of the directories and files on

your workstation onto tape.

Any type of storage media that your

server can back up to: magnetic tape,

floppy disk, or optical disk.

Changing the view to display only the

top level of a highlighted directory in a

window.

A database on the NetWorker server that

contains an entry for every file backed

up.

Changing the view to display all the

levels of a directory in a window.

The device that is attached to the

NetWorker server for transferring and

recovering data that has been saved.

All the systems on a network that back

up and recover their data using

NetWorker.
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NetWorker server

recover

selection

tree structure

The system that backs up all the other

systems on a network according to a

schedule and maintains an on-line index

of everything it backs up.

Replace a lost file with a copy of it from

the NetWorker server.

The name of the volume, directory, or

file highlighted in any window.

A view that displays the contents in a

window in a hierarchical form.
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1. Anorder can be placed with the TIPS group in two ways:

a) MATL ORDER - Use the order form on the opposite page and fill in all requested information. Be sure to include

shipping charges and local sales tax. If applicable, write in your tax exempt number in the space provided on the

order form.

Send your order form with payment to: Data General Corporation

ATTN: Educational Services/TIPS G155

4400 Computer Drive

Westboro, MA 01581-9973

b) TELEPHONE - Call TIPS at (508) 870-1600 for all orders that will be charged by credit card or paid for by pur-

chase orders over $50.00. Operators are available from 8:30 AM to 5:00 PM EST.

METHOD OF PAYMENT

2. As acustomer, you have several payment options:

a) Purchase Order - Minimum of $50. If ordering by mail, a hard copy of the purchase order must accompany order.

b) Check or Money Order - Make payable to Data General Corporation.

c) Credit Card - A minimum order of $20 is required for Mastercard or Visa orders.

SHIPPING

3. To determine the charge for UPS shipping and handling, check the total quantity of units in your order and refer to the

following chart:

Total Quantity Shipping & Handling Charge

1-4 Units $5.00

5-10 Units $8.00

11-40 Units $10.00

41-200 Units $30.00

Over 200 Units $100.00

If overnight or second day shipment is desired, this information should be indicated on the order form. A separate

charge will be determined at time of shipment and added to your bill.

VOLUME DISCOUNTS

4. The TIPS discount schedule is based upon the total value of the order.

Order Amount Discount

$1-$149.99 0%

$150-$499.99 10%

Over $500 20%

TERMS AND CONDITIONS

5. Read the TIPS terms and conditions on the reverse side of the order form carefully. These must be adhered to at all times.

DELIVERY

6. Allow at least two weeks for delivery.

RETURNS

7. Items ordered through the TIPS catalog may not be returned for credit.

8. Order discrepancies must be reported within 15 days of shipment date. Contact your TIPS Administrator at (508) 870-

1600 to notify the TIPS department of any problems.

INTERNATIONAL ORDERS

9. Customers outside of the United States must obtain documentation from their local Data General Subsidiary or Represen-

tative. Any TIPS orders received by Data General U.S. Headquarters will be forwarded to the appropriate DG Subsidiary

or Representative for processing.





TIPS ORDER FORM
Mail To: Data General Corporation

Attn: Educational Services/TIPS G155

4400 Computer Drive

Westboro, MA 01581 - 9973

COM PANY NAME COMPANY NAME

(Agrees to terms & conditions on reverse side)

ATTN: ATTN:

ADDRESS ADDRESS (NO PO BOXES)

CITY CITY

STATE ZIP STATE ZIP

Priority Code (See label on back of catalog)

Authorized Signature of Buyer Title Date Phone (Area Code) Ext.

shipment and added to your bill.

[] UPS Blue Label (2 day shipping)
O Red Label (overnight sipping)

a Purchase Order Attached 1 ($50 minimurn)
P.O. number is (include hardcopy P.O.)

[-] Check or Money Order Enclosed

Cj Visa [] MasterCard ($20 minimum on credit cards)

Account Number

Litt et tt tt Tet tty

Expiration Date

[TTT

Authorized Signature

(Credit card orders without signature and expiration date cannot be processed.)

S ORDER TOTAL

O SP theme 5 E00 Order Amount Save cess Discount -
5-10 ltems $ 8.00 $0 - $149.99 0% Tax Exemot # =<
11-40 Items $ 10.00 $150 - $499.99 10% or Sales Tax SUB TOTAL
41-200 Items $ 30.00 Over $500.00 20% f i

200+ Items $100.00 (if applicable) Your local* +
sales tax

Shipping and +
Check for faster delivery handling - See A

Additional charge to be determined at time of TOTAL -SeeC

THANK YOU FOR YOUR ORDER

PRICES SUBJECT TO CHANGE WITHOUT pric NOTICE.
PLEASE ALLOW 2 WEEKS FOR DELIVERY

NO REFUNDS NO RETURNS.

* Data General is required b % law to collect applicable sales or use tax on all purchases
shipped to states where DG maintains a place of business, which covers all 50 states.
Please include your local taxes when determining the total value of your order. If you
are uncertain about the correct tax amount, please call 508-870-1600.
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DATA GENERAL CORPORATION

TECHNICAL INFORMATION AND PUBLICATIONS SERVICE

TERMS AND CONDITIONS

Data General Corporation (“DGC”) provides its Technical Information and Publications Service (TIPS) solely in accordance with the following

terms and conditions and more specifically to the Customer signing the Educational Services TIPS Order Form. These terms and conditions

apply to all orders, telephone, telex, or mail. By accepting these products the Customer accepts and agrees to be bound by these terms and

conditions.

1. CUSTOMER CERTIFICATION

Customer hereby certifies that it is the owner or lessee of the DGC equipment and/or licensee/sub-licensee of the software which is the subject

matter of the publication(s) ordered hereunder.

2. TAXES

Customer shall be responsible for all taxes, including taxes paid or payable by DGC for products or services supplied under this Agreement,

exclusive of taxes based on DGC’s net income, unless Customer provides written proof of exemption.

3. DATA AND PROPRIETARY RIGHTS

Portions of the publications and materials supplied under this Agreement are proprietary and will be so marked. Customer shall abide by such

markings. DGC retains for itself exclusively all proprietary rights (including manufacturing rights) in and to all designs, engineering details and

other data pertaining to the products described in such publication. Licensed software materials are provided pursuant to the terms and conditions

of the Program License Agreement (PLA) between the Customer and DGC and such PLA is made a part of and incorporated into this Agreement

by reference. A copyright notice on any data by itself does not constitute or evidence a publication or public disclosure.

4. LIMITED MEDIA WARRANTY

DGC warrants the CLI Macros media, provided by DGC to the Customer under this Agreement, against physical defects for a period of ninety

(90) days from the date of shipment by DGC. DGC will replace defective media at no charge to you, provided it is returned postage prepaid to

DGC within the ninety (90) day warranty period. This shall be your exclusive remedy and DGC’s sole obligation and liability for defective media.

This limited media warranty does not apply if the media has been damaged by accident, abuse or misuse.

5. DISCLAIMER OF WARRANTY

EXCEPT FOR THE LIMITED MEDIA WARRANTY NOTED ABOVE, DGC MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING,

BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY AND FITNESS FOR PARTICULAR PURPOSE ON ANY OF THE PUBLICA-

TIONS, CLI MACROS OR MATERIALS SUPPLIED HEREUNDER.

6. LIMITATION OF LIABILITY

A. CUSTOMER AGREES THAT DGC’S LIABILITY, IF ANY, FOR DAMAGES, INCLUDING BUT NOT LIMITED TO LIABILITY ARISING OUT

OF CONTRACT, NEGLIGENCE, STRICT LIABILITY IN TORT OR WARRANTY SHALL NOT EXCEED THE CHARGES PAID BY CUSTOMER

FOR THE PARTICULAR PUBLICATION OR CLI MACRO INVOLVED. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO CLAIMS

FOR PERSONAL INJURY CAUSED SOLELY BY DGC’S NEGLIGENCE. OTHER THAN THE CHARGES REFERENCED HEREIN, IN NO

EVENT SHALL DGC BE LIABLE FOR ANY INCIDENTAL, INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUD-

ING BUT NOT LIMITED TO LOST PROFITS AND DAMAGES RESULTING FROM LOSS OF USE, OR LOST DATA, OR DELIVERY DELAYS,

EVEN IF DGC HAS BEEN ADVISED, KNEW OR SHOULD HAVE KNOWN OF THE POSSIBILITY THEREOF; OR FOR ANY CLAIM BY ANY

THIRD PARTY.

B. ANY ACTION AGAINST DGC MUST BE COMMENCED WITHIN ONE (1) YEAR AFTER THE CAUSE OF ACTION ACCRUES.

7. GENERAL

A valid contract binding upon DGC will come into being only at the time of DGC’s acceptance of the referenced Educational Services Order Form.

Such contract is governed by the laws of the Commonwealth of Massachusetts, excluding its conflict of law rules. Such contract is not assignable.

These terms and conditions constitute the entire agreement between the parties with respect to the subject matter hereof and supersedes all

prior oral or written communications, agreements and understandings. These terms and conditions shall prevail notwithstanding any different,

conflicting or additional terms and conditions which may appear on any order submitted by Customer. DGC hereby rejects all such different,

conflicting, or additional terms.

8. IMPORTANT NOTICE REGARDING AOS/VS INTERNALS SERIES (ORDER #1865 & #1875)

Customer understands that information and material presented in the AOS/VS Internals Series documents may be specific to a particular revision

of the product. Consequently user programs or systems based on this information and material may be revision-locked and may not function

properly with prior or future revisions of the product. Therefore, Data General makes no representations as to the utility of this information and

material beyond the current revision level which is the subject of the manual. Any use thereof by you or your company is at your own risk. Data

General disclaims any liability arising from any such use and | and my company (Customer) hold Data General completely harmless therefrom.
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